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Getting Started with
Your All-In-One E-Sticker

Using the All-In-One E-Sticker is a simple process. Before you begin, however, we highly recommend
that you keep an original, untouched set of PDFs as a backup.

You have chosen one of the following four All-In-One styles. Your options will vary slightly based on how
many fields your E-Sticker contains. We will use Style 1 as an example throughout the User Guide, so please
send us an email at questions@exhibitsticker.com if you need assistance with the other styles.

All-In-One (Style 1) All-In-One (Style 2)
* E-Sticker Title * E-Sticker Title
* Small Sub-Title

Plaintiff's
Exhibit

PX-009

DEFENDANT'S
EXHIBIT

sSmith v. Jones

DX00003

E
g
%
2
i

exhibitstickercom

All-In-One (Style 3) All-In-One (Style 4)
* E-Sticker Title * E-Sticker Title
* Small Header * Small Footer

Case: abe/123456-XYZ

Trial Exhibit ¢ Depo Exhibit

EX-A

Case: abc/123456-XYZ

EX-002
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How to Install the

All-In-One E-Sticker (PC Version)

A Note About Requirements

Adobe Acrobat Standard or Pro (version X, Xl or DC)
Adobe Acrobat Reader Xl or DC

Download Your E-Sticker File

A product download link and a registration key code was emailed to you after purchasing the
All-In-One E-Sticker .

If you have not received your download email, please check your spam/junk mail folder or your
2"d email account (PayPal users will receive an email associated with that account) .

Double click on your

Installing Your E-Sticker File executable file (Note:

your file name will reflect

IMPORTANT: If you have Adobe® Acrobat open, please close it before your purchase.) )

beginning the E-Sticker installation process. ‘a’

Click on the download link in your confirmation email or from the

web pop up window. This will download an executable file to the gi0s1.exe
place of your choosing. (If you have trouble locating the executable TIP: If you copy the
file after downloading it, check your Downloads folder located here: key code before you
My Computer > My Documents > Downloads or your web browser's begin the installation
download icon). process, the key code
will automatically
Next, double click on the executable file to begin the installation appear in the
process. registration box.

A

e

You will be asked to enter a product registration key code which you R
will find within your confirmation email.

You will be notified when the installation process is complete.

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
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Instructions for Adobe Acrobat

Version DC

Setting the Properties for Your All-In-One E-Sticker

Open a PDF document in Adobe® Acrobat DC. You should see a new pop-out tool bar item called “E-Sticker | Style 1
Props.” Click this button to bring up your E-Sticker Properties box.

Add-on Tools

x

E-Sticker | Basic Props ﬂ?| E-Sticker | Style 1 Props I [5 E-Sticker | Style2 Props  [5Y] E-Sticker | Style3 Props  [BpY| E-Sticker | Style4 Props

This Properties box will allow you customize your
All-In-One E-Sticker:

Enter an E-Sticker Title (i.e.,

Defendant’s Exhibit, Deposition Exhibit
etc...)

>

Configure Exhibit Sticker

E-Sticker Properties for All-In-0One | Style 1:

E-Sticker Title: |p) ATNTIFF'S EXHIBIT

Background Color

) vellow {IRed
{1 Blue {1 Gold

Select a Background Color

Enter a Prefix or Remove if

»  (Owhite () Tan
() Green ) Purple
() Orange 1 Pink,

Srnith

not Needed

AUTO INCREMENTING

Enter a Starting Number

Or enter a Starting Letter

If you are using letters,
choose AA, AB or AA, BB, etc.

MANUAL ENTRY

(A separate dialog box will appear each time you place
your E-Sticker.)

Select OK

» Prefix:
(Dptional)

Auto Incrementing (select one)

(%) Skarting Mumber: 020

{} Starting Letter:

£, B...A8, AB
A, E...A8, BB

{3 Manual Entry

> [ Ok, l [ Cancel

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
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Instructions for Adobe Acrobat

Version DC

Finding the Properties for Your All-In-One E-Sticker

If the Add-on Tools pop up window doesn’t appear or has been closed, you can always locate it by clicking on the Tools
tab or by searching under the Tools tab.

Hom« | Tools |[Document

Q s
o 0 2 e &
Export PDF Create PDF Edit PDF Comment Fill & Sign Send for Signature Send & Track Stamp
Open |~ Open | = Open |~ Open | = Open |~ Open | = Open |~ Open | =
ﬁ@ O & @ [
Certificates Measure Organize Pages Enhance Scans Protect Combine Files Prepare Form Optimize PDF
Open |~ Open | = Add |~ Add |+ Add |~ Add |+ Add |~ Add |+
3] ® o
Redact Compare Documents Send for Comments Action Wizard Create Custom Tool Print Production Accessibility PDF Standards
Add |~ Add |+ Add |~ Add |+ Add |~ Add |+ Add |~ Add | -
Rich Media JavaScript Index Add-on Tools
Add |~ Add | = Add |~ Open | =
ﬁ Create PDF
If you are using Acrobat Pro, I it oo
i
H “ ” +
then you can click “Add” and M LS
H H Export PDF
the Add-on Tools icon will be — B e
loaded on the right side , Comment
h C | b Organize Pages Enhance Scans Protect
Short Cut tool bar. ‘
Open |+ Open |~ Open | ~ Organize Pages
l& Enhance Scans
r O Protect
& . A Fill & sign
Stamp Add-on Tools Action Wizard @ Prepare Form
Open |~ Open | ~ Open | ~ N x&  Send for Signature
Y - Send & Track
\ 8. Stamn
X ~ -
a‘ Add-on Tools
A" - -
nd for Comments Create Custom Too Print Produrt- _ =™ Aetien Wizard
Add | - Add | v Add | -
©2015 All rights reserved. ExhibitSticker.com is a subsidiary of 6
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Instructions for Adobe Acrobat Version DC

Selecting Your All-In-One E-Sticker

With Acrobat DC, the All-In-One E-Sticker can be accessed from the Tools tab.

Home Tools Document

& ﬁ é w Lone > L_{=LJ

Export PDF Create PDF Edit PDF Comment Fill & Sign Send for Signature Send & Track Stamp

Q) Search Tools...

Open | = Open | = Open | = Open | = Open | = Open | ~ Open | = Open | =

é‘i’ O & @ L
Certificates Measure Organize Pages Protect Combine Files Prepare Form Optimize PDF
Open | v Open |+ Add |~ Add |~ Add |~ Add |~ Add |~ Add |~
Redact Compare Documents Send for Comments Action Wizard Create Custom Tool Print Production Accessibility PDF Standards
Add |+ Add |~ Add |+ Add |~ Add |+ Add |~ Add |+ Add |~
H E
Rich Media JavaScript Index Add-on Tools
Add - Add | - Add - Open |~

a Create PDF

If you are using Acrobat Pro, .
then you can click “Add” and M LS
the Stamp icon will be - B Exporteor
loaded on the right side i Comment
h ¢ C tt | b Jrganize Pages Enhance Scans Protect
Short Cut tool bar. apen |~ Open | - Open | = Organize Pages
IE| Enhance Scans
O Protect
& /A, Fill & Sign
Stamp Add-on Tools Action Wizard @ Prepare Form
Open |~ Open | Open | = » xk Send for Signature
< E
-»- Send & Track
& Stamp
¢'| | '$‘ | “4' ST AUQ-UN OIS ”
nd for Comments Create Custom Tool Print Production El Action Wizard
Add |~ Add | = Add | =
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Instructions for Adobe Acrobat Version DC

Placing Your All-In-One E-Sticker

Click on the Stamp icon and a Stamp tool bar appear at the top of the document. Select the E-Sticker
and you will see a transparent version of the exhibit sticker that will move with your mouse. Hover
your mouse over the area where you would like to place your stamp and click your mouse on that
position to place the E-Sticker. If you have chosen to use the auto-incrementing feature the first stamp
will begin with your starting number/letter that you entered into the properties box.

Home Tools Document E =5 Q /1
E Stamp~ &. Stamp ~ ,g‘-. Stamps Palette & Custom Stamps = Bates Numbering +
'APPROVED

E-Sticker | All-in-One » Plantiffs
Exhibit
E-Sticker | Basic - Blue Pack 3 Smith020
Nov. 3, 1925. ' 1,560,086

J, ©O. HEARN
FUMP JACK
Filed April 30, 1225

TIP: you can move, delete
or resize the E-Sticker once
it has been placed. See
page 18.

PLAINTIFF'S
EXHIBIT

Smith020

That’s it! When you open up your next document, it will automatically remember the last number or
letter you used and auto-increment to the next number or letter. If you are working on a different
case, just re-set your properties in the Properties Dialog Box before selecting your All-In-One E-Sticker
and your E-Sticker will populate with the new information.

Be sure to check out the Quick Tips section for ways to speed up the stamp placement process.

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
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Instructions for Adobe Acrobat Version DC

Placing Your All-In-One E-Sticker
(Manual Entry)

If you have selected the Manual Entry button in your properties box, when you select your E-Sticker
you will see a transparent version of the exhibit sticker that will move with your mouse. Hover your
mouse over the area where you would like to place your stamp and click your mouse on that

position. A dialog box will pop up asking you to enter the information to appear on the exhibit
sticker.

Nov. 3, 1925. 1,560,086

J, ©. HEARN
FUHP JACK

Filed April 30, 1925

1 Exhibit Number: %
Click OK
V4

J

Once the information has been entered and you select OK, the E-Sticker will appear on your
document.

When you open up your next document to add an exhibit sticker, a new dialog box will appear. You
will be able to enter the exhibit information for your new document.

Cool Tip: Blank Exhibit Stickers

You can always add a blank exhibit sticker to your PDFs
by leaving the Manual Entry field blank. This can be
useful If you are going into a situation where you might
not know the exhibit numbers, such as a deposition.

{

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of 9
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Instructions for Adobe Acrobat

Standard/Pro Version X & Xl

Setting the Properties for Your All-In-One E-Sticker

The first step is to set the properties for your E-Sticker. This is where you will enter the Exhibit sticker
title, prefix, header/footer and starting number/letter. Once you set your properties you will not have
to revisit this dialog box unless you need to use the E-Sticker on another case and need to set up new
parameters.

Open a PDF document in Adobe® Acrobat Professional Version X or XI. Under the Tools Menu, you
should see a tool bar item called “Add-On Tools”. Open this menu and select the “E-Sticker | Style 1
Props.” Click this button to bring up your E-Sticker Properties box.

#8 USPatent1560086. pdf. - Adobe Acrobat Pro

et Vi Wion - TIP: If you right
foae- B BE@ 202D R & < click on the icon

® Il (=) () [s03% ools omment | Share
O] WMo | O@MnT | HE GG J conmart | store |61 can select “Add

e to quick tools and
» Forms the E-Sticker icon
» Action Wizard .
e will be added to
va‘ 3. 1925- J. O. HEARN ljwm .
et o  Protection your menu bar.

» Sign & Certify

» Document Processing

'v Add-on Tools l \._.;
—_— s
E E-Sticker | Style 1 Props

Filed April 30, 1325 b |

Configure Exhibit Sticker

Enter the information relevant to your case: E-Sticker Properties for All-In-One | Style 1:

Enter an E-Sticker Title (i.e., Defendant’s e—) | E-Sticker Title: PLATNTIFF'S EXHIBIT
Exhibit, Deposition Exhibit, etc...)

Background Color

() Yellow i Red
) Blue () Gold
Select a Background Color T Oowhite Otan
() Green ) Purple
() Crange ) Pink
Smith
Enter a Prefix (or leave blank if not needed) P Prefix:
{Optional)

() Ak Incrementing (select one)

AUTO INCREMENTING

Enter a Starting Number (® Starting Mumber;  |020

() starting Letker:

&, B...48, AB

or enter a Starting Letter

If you are using letters,

choose AA, AB or AA, BB, etc. A, B A, BB

MANUAL ENTRY (O Manual Entry

(A separate dialog box will appear each time you place
your E-Sticker. Leave blank if want a blank exhibit sticker)

Select OK Gl [ oK ][ Cancel

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
The Exhibit Company. www.exhibitsticker.com
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Instructions for Adobe Acrobat Standard/Pro

Version X & XI

Selecting Your All-In-One E-Sticker

Once you have set your E-Sticker properties, you will then select the All-In-One E-Sticker and
begin stamping.

Access your E-Sticker by selecting: Comment > Annotations and selecting the Stamp Icon pull
down menu. You will see a menu item called “E-Sticker | All-In-One”. Open this menu item and
choose your All-In-One E-Sticker.

»% USPatent1560086.pdf - Adobe Acrobat Pro 9[i=1E3]
File Edit Wiew Window Help *®

foae- | D P G DT | @02 BD R & ]
j,/ 2 ‘ &M :jEj: :j:.i-:: ‘ iR T(@[Comment Share

q I' Annotations

' | > o NG(E

(APPROVED|  |”

| Nov. 3, 1925. ' 1,560
L5 J. O. HEARN /560,086 ]
Show Skamps Palette

[
>

FUNP JACK

Filed April 30, 1925 PLAINTIFF'S E-Sticker | All-In-Cne
EXHIEIT A
Drynamic 3
Smith020 )
— Sign Here r
Skandard Business L4

Add Current Stamp Ta Favorites

Cuskorn Stamps 4

& Paste Clipboard Image as Stamp Tool

|

. . 3
Quick Tip: =10l x|
— L Plelp
: le Analyt
e R S —
— —
p— a | ﬁ Tools ;. Comment : Share m 2
NOTE: You can easily add A Annotati B fserser  videoDoest [,
L
a Stamp Tool shortcut to nnotatiens |
your Quick Tools toolbar .
by right clicking on the e bz @D E@ & -
Tool Default Properties
Stamp Tool button and . &% = T B
selecting “Add to Quick — @ = Keep Tool Selected
Tools.”
* Drawing Markups —n
©2015 All rights reserved. ExhibitSticker.com is a subsidiary of 11
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Instructions for Adobe Acrobat Standard/Pro

Version X & XI

Placing Your All-In-One E-Sticker
(Using the Auto Incrementing Feature)

Once you have selected the All-In-One E-Sticker you will see a transparent version of the exhibit
sticker that will move with your mouse. Hover your mouse over the area where you would like to
place your stamp and click your mouse on that position to place the E-Sticker. If you have chosen to
use the auto-incrementing feature the first stamp will begin with your starting number/letter that
you entered into the properties box.

_L‘ USPatent1560086. pdf - Adobe Acrobat Pro E]E]
File Edit Wiew Window Help *®
EE Create ~ @ @ @ | {‘é} @ @ @ D‘) @) |z|

(= & | [ Tools Comment Share

| >

@[]z NG

» Pages

» Content

» Forms

» Action Wizard

» Recognize Text

» Protection

» Sign & Certify

» Document Processing

+ Add-on Tools

E E-Sticker | Style 1 Props

“}’M TIP: you can move, delete,
"0 arronney ’ rotate or resize the E-
/| Sticker once it has been
PLAINTIFF'S g ~
EXHIBIT placed. See page 18.

Smith020

That’s it! When you open up your next document, it will automatically remember the last number or
letter you used and auto-increment to the next number or letter. If you are working on a different
case, just re-set your properties in the Properties Dialog Box before selecting your All-In-One E-
Sticker and your E-Sticker will populate with the new information.

Be sure to check out the Quick Tips section for ways to speed up the stamp placement process.

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
The Exhibit Company. www.exhibitsticker.com
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Instructions for Adobe Acrobat Standard/Pro

Version X & XI

Placing Your All-In-One E-Sticker
(Manual Entry)

If you have selected the Manual Entry button in your properties box, when you select your E-Sticker
you will see a transparent version of the exhibit sticker that will move with your mouse. Hover your
mouse over the area where you would like to place your stamp and click your mouse on that
position. A dialog box will pop up asking you to enter the information to appear on the exhibit
sticker.

g_USPatenﬁ 560086.pdf - Adobe Acrobat Pro

|>

fleae- | DB O EHZ &0z DL E B4
:i,; [ 2 | ]:k @ | ;E; @ | @ Tools Comment Share
. Iz RAEEEEE o ] E-

» Pages

» Content

» Forms

» Action Wizard

» Recognize Text

» Protection

» Sign & Certify

» Document Processing

v Add-on Tools

s informa
K tion and
[ click 0k

|

E E-Sticker | Style 1 Props

o

Once the information has been entered and you select OK, the E-Sticker will appear on your
document.

When you open up your next document to add an exhibit sticker, a new dialog box will appear. You
will be able to enter the exhibit information for your new document.

Cool Tip: Blank Exhibit Stickers

You can always add a blank exhibit sticker to your PDFs

by leaving the Manual Entry field blank. This can be
/ useful If you are going into a situation where you might
pe==—r not know the exhibit numbers, such as a deposition.

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
The Exhibit Company. www.exhibitsticker.com

13



http://www.exhibitsticker.com/

Instructions for Adobe Acrobat

Reader Xl

Setting the Properties for Your All-In-One E-Sticker

Open a PDF document in Adobe® Acrobat Reader XI. Under the Extended Menu, you should see a tool
bar item called “Add-On Tools”. Open this menu and select the “E-Sticker | Style 1 Props.” Click this
button to bring up your E-Sticker Properties box.

e8 UsPatent1 560086.pdf - Adobe Reader

File Edt View Window Help x
@% Ef}, Zr & (gj | lr /2 | — ‘ Iz‘ = Tools : Sign Comment rExtended
T | = Faadontoos [T TIP: If you right click
: B e Tese s on the icon you can
s T W sclect “Adid 1o quick
Nov. 3, 1925. . 1,560,086 B sk | v 4 Pros tOOIS and the E-
FF e 5 £ stior Propertis Sticker icon will be  “F
ri.m april 30, 1925 L added to your menu -
bar.

Configure Exhibit Sticker

Enter the information relevant to your case: E-Sticker Properties for All-In-One | Style 1:

Enter an E-Sticker Title (i.e., Defendant’s ﬁ E-sticker Title: |PLF\INTIFF'5 EXHIBIT
Exhibit, Deposition Exhibit, etc...)

Background Color

) vellow (I Red
| Id
Select a Background Color > Ol Oo
) wehite I Tan
iiGreen JPurple
) Orange Pk
Srith

Enter a Prefix (or leave blank if not needed) P Prefix:
({iptional}

(%) duto Incrementing (select one)

AUTO INCREMENTING

Enter a Starting Number () Starting Mumber: 020

O Skarting Letter:

&, B.. A6, AB

or enter a Starting Letter

If you are using letters,

choose AA, AB or AA, BB, etc. &, B...08, BB

MANUAL ENTRY () Manual Entry

(A separate dialog box will appear each time you place your
E-Sticker. Leave blank if want a blank exhibit sticker)

Select OK

e I Ok ] [ Cance|

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
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Instructions for Adobe Acrobat Reader Xl

Selecting Your All-In-One E-Sticker

Once you have set your E-Sticker properties, you will then select the All-In-One E-Sticker and
begin stamping.

Access your E-Sticker by selecting: Comment > Annotations and selecting the Stamp Icon pull
down menu. You will see a menu item called “E-Sticker | All-In-One”. Open this menu item and
choose your All-In-One E-Sticker.

g2 UsPatent1 560086. pdf - Adobe Reader
File Edit Wiews ‘window Help

é% @ T & E',) ‘ lr iz | — ‘ |z| > Tools { ramment—! Extended
) A

nnotations

® B TM&-

| APPROVED |

Nov. 3, 1925. 1,560,086
J. O. HEARN
FUMP JACK Showe Stamps Palette
Filed April 20, 1925 PLAINTIFF'S E-Sticker | All-In-Cne
EXHIBIT .
Drynamic 3
Smith020 )

—————— Sign Here 4
Standard Business 4

Add Current Stamp Ta Favarites

- B-
Custarn Stamps » nments.
é Paste Clipboard Image as Stamp Tool
. . ¥4
aueTie: BT
/"* ® |
: le Analyti
ErEX{) El==
—
p— a | = Tools : Comment @ Share m 2
NOTE: You can easily add A Annotati B fserser  videoDoest [,
L
a Stamp Tool shortcut to Anetstiens |
your Quick Tools toolbar .
by right clicking on the e B2 @D E@ & M
Tool Default Properties
Stamp Tool button and . &% = T B
selecting “Add to Quick — @ = Keep Tool Selected
Tools.”
* Drawing Markups ; —n
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Instructions for Adobe Acrobat Reader Xl

Placing Your All-In-One E-Sticker
(Using the Auto Incrementing Feature)

Once you have selected the All-In-One E-Sticker you will see a transparent version of the exhibit
sticker that will move with your mouse. Hover your mouse over the area where you would like to
place your stamp and click your mouse on that position to place the E-Sticker. If you have chosen to
use the auto-incrementing feature the first stamp will begin with your starting number/letter that
you entered into the properties box.

»8 USPatent1560086. pdf - Adobe Reader =3
File Edit Wiew Window Help *

é% @ Z @ 5 (% | lr {2 | — | @ > Tools Sign Comment Extended

#| » Annotations

BT RD &
Tn % + I B T
Nov. 3, 1925. ) ;D HEARN ) 1,560,086 + Drawing Markups
PUMP JACK

Filed April 30, 1925 E\Ql = = "\:/" O
| | SRORANA

* Comments List {0)

G Jro B

This document has no comments.

TIP: you can move, delete
or resize the E-Sticker once

PL;,::ET:'S ) it has been placed. See
18.
Smith020 page 18 ||

That’s it! When you open up your next document, it will automatically remember the last number or
letter you used and auto-increment to the next number or letter. If you are working on a different
case, just re-set your properties in the Properties Dialog Box before selecting your All-In-One E-
Sticker and your E-Sticker will populate with the new information.

Be sure to check out the Quick Tips section for ways to speed up the stamp placement process.
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Instructions for Adobe Acrobat Reader Xl

Placing Your All-In-One E-Sticker
(Manual Entry)

If you have selected the Manual Entry button in your properties box, when you select your E-Sticker
you will see a transparent version of the exhibit sticker that will move with your mouse. Hover your
mouse over the area where you would like to place your stamp and click your mouse on that
position. A dialog box will pop up asking you to enter the information to appear on the exhibit

sticker.

pX USPatent1 560086.pdf - Adobe Reader
File Edit Wiew ‘Window Help

*®

é% @ F & (% ‘ l- {2 ‘ — ‘ E = Tools Sign Comment Extended

L. #| » Annotations

EPBT &Y &-
Tn %+ I B T

Nov. 3, 1925. . 1,560,086 ~ Drawing Markups
J. ©. HEARN
FUMP TAGK o -
/ Filed April 30, 18235 ’ Eﬁk — = O O
@ — N o -
Exhibit Number: X OO 2 F
Enker Exhibit Letter/Mumber Click OK -
1 V4 » Comments List (0}
. g o &
K Cancel
5 This document has no comments.
— =
WA\ ;. Bl /

Once the information has been entered and you select OK, the E-Sticker will appear on your
document.

When you open up your next document to add an exhibit sticker, a new dialog box will appear. You
will be able to enter the exhibit information for your new document.

Cool Tip: Blank Exhibit Stickers

You can always add a blank exhibit sticker to your PDFs
by leaving the Manual Entry field blank. This can be
useful If you are going into a situation where you might
not know the exhibit numbers, such as a deposition.

{
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Working with your E-Sticker

All Versions

Moving Your E-Sticker
NG

6,149,521

United States Patent (1
5 X Nov. 21,2000

If you have placed the E-Sticker in somto

ER GAME WITH MULTIPLIER

a bad spot, simply click on the
exhibit sticker and hover over the gl

center until you see the Move
Crosshairs. Once you see the

crosshairs, click and hold with

your mouse and drag the E- 0010+ 1000 Drag to move
i «  your E-Sticker

Lo |[0,0 |0 o [['® v |W40
o (0% |00 a0l

) s, | 999
DBy 0 01| 99| 47| 47 4,
B %  w w

i 7 7 T

T
28
-

Sticker to a new spot

Deleting your E-Sticker

® To delete an E-Sticker, click on the existing E-Sticker select the Delete key or
right click on the E-Sticker and select Delete from the pull down menu.

Editing your Exhibit Number

®* If you have typed in the wrong exhibit number or need to make a change for
some reason, simply click on the existing E-Sticker and delete it using the
Delete key or by right clicking on the E-Sticker and selecting Delete. Then
apply a new E-Sticker with the correct information.
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Working with your E-Sticker

All Versions

Re-Sizing Your E-Sticker

The E-Sticker has been standardized to reflect a physical exhibit sticker on an 8.5 x 11
document. If you have larger documents (i.e., plats, maps) or smaller documents (i.e.
photos) you can easily re-size the E-Sticker. Click on the E-Sticker and hover over one of
the four corners of the E-Sticker and a Re-Size arrow will appear. Drag the corner of the E-
Sticker out (away from the E-Sticker to make it larger or in (toward the center of the E-
Sticker) to make it smaller.

&

TRIAL
EXHIBIT

TRIAL

EXHIBIT DX-2002

DX-2002

Rotating Your E-Sticker

In some instances you might need to rotate the E-Sticker to orient it
properly to your document. Click on the E-Sticker and hover over
the white circle above the middle of the E-Sticker. You will see a
rotate arrow appear. Click on the rotate arrow and rotate the sticker
to the appropriate position.

EXHIBIT

PX-134

Adding a Blank E-Sticker

You can always add a blank exhibit sticker to your PDFs by leaving the
Manual Entry field blank. This can be useful If you are going into a
situation where you might not know the exhibit numbers, such as a
deposition.

EXHIBIT
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Working with your E-Sticker

All Versions

Working With Unusual Numbers, Letters or Special Characters

Sometimes you might need to use a combination of letters and numbers or you have decimal points.
Here are two examples of common situations we’ve run into solutions using the E-Sticker:

Decimals:

If you need to use a decimal in your exhibit number, such as Smith-001.001, Smith-001.002, Smith-
003.003, etc., enter everything including the decimal into the Prefix box, and set the Starting
Number to the first number or letter that comes after the decimal:

Configure Exhibit Sticker |Sm|th-|:||:| i,
E-Sticker Properties for All-In-One | Style 1: Prefix:
E-Sticker Title: ’W .
Background Color I:Dptll:lnal:l
@ vellow ORed
e o (¥ Auto Incrementing (select one)

O ereen O Purple
Oorange Orink

(%) Skarting Mumber: |':":'1

Srith-001,
Prefix:
(Optioral)
() Auto Incrementing (select one)
(%) Starting Mumber 0oL
) Starting Letter: al FLAINTIFFIS §
o
EXHIBIT  :
i, ... A, BB
O Manual Entry E
Smith-001.001

Number/Letter Combinations:

If you need to use a combination of letters and numbers such as Smith-A1, Smith-A2, Smith-A3,
etc., enter everything including the letter into the Prefix box and set the Starting Number to the
first number that comes after the letter:

Configure Exhibit Sticker

E-Sticker Properties for All-In-One | Style 1: -
E-sticker Titler [pLAINTIFF'S EXHIEIT P r . |SI-|-|":'-|_'|:'|
Background Color FETTH:
@ vellow Ored .
Oiue O Gold {Optmna”
O White OTan
Orreen Opurple
Ceme (R {E} Aubn Incrementing (seleck one)
T
(Gptional) .
@Autul:zremenling(;elettune) @ Etartll'lg NumbEr: |1
@ Starting Number i
O Starting Letter "“—
&,B...48, BB Glmins) .
_— PLAINTIFF'S §
/anual Entry
EXHIBIT é
Smith-A1

For other unusual combination of letters, numbers and characters, you can always use the Manual Entry
box in the Properties Dialog Box which allows you to enter anything you would like as your exhibit
number.

©2015 All rights reserved. ExhibitSticker.com is a subsidiary of
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Time Saving Tips

All Versions

These two tips will help speed up the E-Sticker process. Be sure to check them out.

Adding Your E-Sticker to the “Favorites” Menu

After you have placed your E-Sticker you can make the process even easier by adding the E-Sticker
to your Favorites menu in a few simple steps:

1. Using the Select tool or the Hand tool, select the E-Sticker on the page.

2. With the E-Sticker selected, go to the Comment & Markup toolbar, click the Stamp tool and
choose Favorites > Add Current Stamp To Favorites.

Version X & XI

Your favorite Ey Y — . — 'MJ If you are using Acrobat Pro

stickers are now | & ‘:‘““f‘,‘}‘@;*‘a ﬁ_‘iiﬁ w0 O N | DC, then you can click “Add”

easy to access! E ; ] and the Stamp icon will be ) B
T loaded on the right side O e

E-Sticker

Short Cut tool bar.

White Deposition
Yellow Plaintiff

exhibit
Dynamic
Sign Here

L

‘ﬁmzm=mm= F
= i -
‘é Custom Stamps > @

& Past= Clipboard Image as Stamp Tool

o T T wlor Commrents Creste Custom Tuol Print Preduction B o wizar
s A - e T HE
Dx003

- ) /) This is our favorite
Use shortcut “K” key to place E-Sticker = speed tip!

staep et o i action Wizl

k¥R far}
[

If you set up your preferences to enable single-key shortcuts, you simply have to select the “K” key
anytime you want to place your E-Sticker. This saves a ton of time!

. .
] e Rl To set this up choose Edit > Preferences > General > Use
1 . .
oo LntnCataeny, Gl single-key accelerations to access tools.
Redo Shift+CtrleZ
Cut Ctrl+X HEEEEE -
Copy Ctrl+C e )
ategories: Basic Tools
[5] Paste Ctrl+V
Delete Commenting - Use single-key accelerators to access tools
= Documents | || Create links from URLs
SISO _""'"" | [#] Make Hand tool select text & images
[General |
Select All Ctrl+A ugc = 4 Make Hand tool read articles i
Deselect All Shift+ Ctrl+ A — [ Make Hand tool use mouse-wheel zooming
3D & Multimed
Check Spelling N A:cessil:\i;:;'ni 1 [ Make Select tool select images before text
Look Up Selected Word... Acrobat.com [T Use fixed resolution for Snapshot tool images: 72 5 pixels/inch
Batch Processing
Eind Ctrl+F Catalog Warni
amnings
Search Shift+ Ctrl+F Coler Management
Search Results Convert From PDF £ [ Do not show edit warnings
Convert To PDF
IWH s i

Once you have done this, select the E-sticker you want to use and place it on the page.
When you open your next document, all you will need to do is select the “K” key and your
E-Sticker will be automatically be placed on the page at your next cursor click.
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How to Flatten Your Document

and Why it is Important

As with all Adobe® Acrobat stamps, the E-Sticker is not a part of the base document until
you choose to flatten your PDF.

However, it’s important to flatten the E-Sticker into the base layer of the document at Before manua"y
some point before submitting to the court, opposing counsel or trial technician. This will f|attening your
insure that the E-Sticker is displayed and printed properly. documents make a
Flattening is a simple process but please, please keep a backup set of your documents backup set of your
before flattening! Even though you will be asked to save your file and give it a new name docu ments fI rSt!

or location, it is a best practice to have a back up set tucked away so you don’t
accidentally overwrite your original files. Once you flatten a PDF file, your E-Sticker
becomes a part of the document.

Flattening single documents

The easiest way to flatten a single document is to print it to a PDF file. In
the industry this is know as “re-frying” the document. Simply navigate to
File > Print as if you are going to print your document and select Adobe 6 Make sure Document and
PDF as your printer. Markups is selected here.

pe Chrl+0 Printer
[ = \
= o .
Create POF Portfolio Status:  Ready Comments and Forms:
Modify PDF Partfaolio 3 Type: Adobe PDF Converter Document and Stamps
;_5 Create FDE 3 Prink Fange Previsw: Composite
42 Combine 3 @al E 8.5 |
O Current wiew e
;:] Collaborate 4
O Current page
OPages 1-z2
Save As... Shift+CEr+5 5
Subset: | All pagesin rangs W

® Save as Certified Document. .,
G—B Expart » D Reverse pages

Fage Handling

Attach ko Email... Copies: 1 E Collate 11
Class e Page Scaling: |Shrink to Printable Area w
Properties... Chrl+D [#] Auto-Rotate and Center
Prink Setun. .. ShiFE+Ckrl+-P DChDDSE paper source by PDF page size

[Eﬂ B Qi I Use custom paper size when needed A

T Histor

E ) i . Units: Inches Zoom : 100%
1 .. \F1040s_preflight. pdf [CIPrint ko file
£ Ci\Documents and Settingst...\f1040s.pdf [ IPrint color as black i ]—
3 CADOCUME~1Y,. \Problems (2_25_2012),pdf

r 1
e ’Printing Tips ] [ Advanced l [ Summarize Comments ] [ Ok ] Cancel ]
5 C:iDocuments and Settingst, .. \00335786s, pdf
Exit Ctrl+Q
Click OK and you will be asked to save
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Instructions for Adobe Acrobat — All Versions

Flattening Multiple Documents

If you have hundreds of documents to E-Sticker, it would be tedious to individually flatten each and every document.

There are batch flatteners available to help streamline the process.

We have included links to download our favorite flatteners which work with Adobe® Acrobat X, XI & DC on the home
page of our web site:

www.exhibitsticker.com

Again, please keep an unflattened set of documents in a safe location!

How to Uninstall Your All-In-One E-Sticker

If you ever need to uninstall your E-Sticker, go to Add or Remove Programs in your Control Panel and find the E-Sticker.

Windows XP:
¥ Add or, Remove Programs
%ﬂ Currently installed programs: |:| Show updates Sork by
Change or i )
o Audio video Codec Pack ~
Ao ﬁ! udio video Codec Pac Size 19.34MB A
Programs ﬁl Calar Swatch Add-in Far PowerPaint Size 0.41MB
5! Dell Resource CD Sz 3.76MB
E ca
47 Dropbaox i .
pdd New - P Size 28.25MB
Programs ﬁ@ E-Sticker
E : Toch this program of r Ef ompute : o Change /Remove
AddRemave E-Transcript Bundle Viewer Size  S1.79ME
windows
Camponents & Google Chrome Size 1,052, 00ME
ﬁ‘ Intel{R) PRO Metwork Adapters and Crivers
@' |23 Microsoft Office Professional Plus 2010 Size  385.00MB
et Program P, Micrasoft Online Services Sign-in Assistant Size 3.36ME ¥
Accessand v
Windows 7 & 8:

» Control Panel » Programs » Programs and Features

| Search Programs and Features 2|

Control Panel Home

View installed updates

of

) Turn Windows features on or
ff

Uninstall or change a program

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Organize *  Uninstall/Change = @
Name Publisher Installsd On  Size Version o
[&f Notepad-++ 11/29/2012 622
B8 Adobe AR Adobe Systems Incorporated 12/7/2012 3402710
¥ Ave 2013 AVG Technologies 12/10/2012 201302805
€ iTunes AppleInc. 1/2/2013 191 MB 110112
15 Apple Application Support AppleInc. 1/2/2013 650ME 232
[Slicloud AppleInc. 1/2/2013 819MB 2113

7 Apple Mobile Device Support AppleInc. 1/2/2013 251MB 6013
[ Promo E-Sticker 1/7/2013
7 Drophbox Dropbox, Inc. 1/8/2013 1613
=71 E-Sticker 1/8/2013
[ Adobe Flash Player 11 ActiveX Adobe Systems Incorporated 1/8/2013 600MB 115502146 | _
% Advanced BAT to EXE Converter PRO v2.75 1/9/2013 3
<2 NVIDIA HD Audio Driver13.11.1 NVIDIA Corporation 1/10/2013 13111 -
< i ] v

=
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Troubleshooting

Restart your computer

The first thing to try if you are having any issues with the E-Sticker is to restart your computer. That solves
most of the issues we come across.

My E-Sticker properties box is greyed out

Do you have a document open? You must have a PDF open for the Properties dialog box to function properly.

I can’t find my E-Sticker properties box

The E-Sticker Properties box is located in the Tools | Add-On Tools panel. On some Computers, the Add-
On Tools panel is disabled by default. If you do not see the Add-On Tools panel please try the following:

Select the Tools menu to see if you have the Add-On Tools menu (usually the last item on the list). If not,
click on the small down arrow icon directly under the Comment tab and check the Add-On Tools selection
toward the bottom of the pop-up menu. Once you do that you should see the Add-On Tools menu that is
now available. Your E-Sticker Properties dialog boxes are accessible within this the Add-On Tools Menu.

| cannot install my E-Sticker

In some cases, your anti-virus scanner might interfere with the installation process. Please try disabling or
pausing your anti-virus program and installing again.

| installed my E-Sticker but don’t see it

In some cases, an administrator account is used to install the software. The E-Sticker will only be available or
seen by the admin user. The E-Sticker must be installed in the user account of the user that will be using it.
Also if your firm is using VDI (i.e. Citrix) then you should have your IT department contact us for instructions.

| can see my stamp but | don’t know how to set the
properties

Your E-Sticker Properties are located within the Tools | Add-on Tools Pallet (for Adobe Acrobat Pro) or
Extended | Add-on Tools for Adobe Reader XI. If you have trouble locating the add-on tools pallet, please
see the entry above entry “No Add-On Tools in Adobe Acrobat”

The manual feature is not working

The manual feature on the paid version of the E-Sticker works a bit differently than the free E-Sticker so
some folks might find it confusing the first time they use it. To get the manual box to pop-up you will first
need to select the manual option in the properties box (See above if you have trouble locating the
properties box). Next you will select your E-Sticker from the Stamps Tool. At this point you will need to
place your E-Sticker on the document. Once you place the E-Sticker, the manual box will then come up
where you can then enter your information.

Questions?

You can find the answers to many questions in our FAQ section of at www.exhibitsticker.com. We
also have an extensive library of video tutorials.

If you still need help, please reach out to us through our support ticket form on our website.
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